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BSBTEC301 Design and produce business 
documents 

Application 
This unit describes the skills and knowledge required to design and produce various 
business documents. It includes selecting and using a range of functions on a variety of 
computer applications. 
The unit applies those who possess fundamental skills in computer operations. They may 
exercise discretion and judgement using appropriate theoretical knowledge of document 
design and production to provide technical advice and support to a team. 
No licensing, legislative or certification requirements apply to this unit at the time of 
publication. 

Elements and Performance Criteria  
Element 
Elements 
describe the 
essential 
outcomes. 

Performance Criteria 
Performance criteria describe the performance 
needed to demonstrate achievement of the element. 

Page reference 

1. Select and 
prepare 
resources 

1.1 Select and use technology and software 
applications to produce required business documents 

16–17 

1.2 Select layout and style of publication according to 
information and organisational requirements 

55–65 

1.3 Use basic design principles and ensure document 
design is consistent with organisational requirements  

10, 51–65 

1.4 Discuss and clarify format and style with required 
stakeholder 

10, 69 

2. Design 
document 

2.1 Identify, open and create files according to task 
and organisational requirements 

21–23, 34 

2.2 Design document and ensure efficient entry of 
information 

55–65, 66–70, 
119–121, 135–140 

2.3 Use a range of functions to ensure consistency of 
design and layout 

82–89, 135–140, 
142–144 

3. Produce 
document 

3.1 Complete document production according to 
organisational policies, procedures and requirements 

Throughout 
workbook 

3.2 Check document produced to ensure it meets task 
requirements for style and layout 

66–69 

3.3 Store document appropriately and save document 12, 21–23 
3.4 Use help function to overcome basic difficulties 
with document design and production, where required 

46 
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Element 
Elements 
describe the 
essential 
outcomes. 

Performance Criteria 
Performance criteria describe the performance 
needed to demonstrate achievement of the element. 

Page reference 

4. Finalise 
document 

4.1 Proofread document for readability, accuracy and 
consistency of language, style and layout prior to final 
output 

66–69 

4.2 Modify document according to task requirements 26–29, 66–72, 77 
4.3 Name and store document in accordance with 
organisational requirements and exit application  

12, 21–23, 29 

4.4 Present document according to task requirements 76–77 

Foundation Skills 
This section describes language, literacy, numeracy and employment skills incorporated in 
the performance criteria that are required for competent performance. 

Skill Description Page reference 
Reading • Recognises and interprets textual information 

from a range of sources to determine and adhere 
to requirements 

Throughout 
workbook 

Writing • Develops documents using required format, 
accurate spelling and grammar and terminology 
specific to requirements 

55–72 

• Organises content to support purposes and 
audience of material, using clear and logical 
language 

9–10 

Self-
management 

• Recognises and follows explicit and implicit 
protocols and meets expectations associated with 
own role 

Throughout 
workbook 
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Assessment for this Unit 
This Unit is assessed by creating a: 

• creating a letterhead template 

• creating a letter incorporating data from another Word document 

• creating a leaflet 

• using Help 

• creating a memo incorporating data from a spreadsheet 

• creating a report. 

Assessment Requirements 
Performance Evidence 
The candidate must demonstrate the ability to complete the tasks outlined in the elements, 
performance criteria and foundation skills of this unit, including evidence of the ability to: 

• design, produce and finalise four different types of business documents, using at least 
two different software applications. 

In the course of the above, the candidate must: Page reference 
• comply with organisational policies and procedures for producing 

business documents 
10–13 

• adhere to task requirements when producing documents 
including: 

 

• applying basic design principles 51–54 

• applying consistent formatting 10–11, 83–89, 135–
140, 142–144 

• using appropriate styles 10–11, 83–89 

• using correct layouts 55–65 

• proofreading 66–69 

• use required data storage options. 21–23 

Knowledge Evidence 
The candidate must be able to demonstrate knowledge to complete 
the tasks outlined in the elements, performance criteria and 
foundation skills of this unit, including knowledge of: 

Page reference 

• technology required for document production 16–17 

• key functions and features of contemporary computer applications 16 

• organisational policies and procedures 10–12 

• organisational requirements for document design, including style 
guide. 

10–11 
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Word default style guide 
Layout 
Page size Set to the Australia standard A4 (the USA standard page size is 

called Letter) 
Margins 2.54 cm – the metric equivalent of 1 inch 

Text styles 
Body text (Normal style) Calibri, 11 pt, black, left aligned text, 8 pt spacing after each 

paragraph 
Heading 1 style – for 
document headings 

Calibri Light, 16 pt, blue, 12 pt paragraph spacing above  

Heading 2 style Calibri Light, 13 pt, blue, 2 pt paragraph spacing above 
Heading 3 style Calibri Light, 12 pt, blue, 2 pt paragraph spacing above 
Bulleted paragraphs Black circle bullet indented 0.63 cm from the left margin with text 

indented 0.63 cm from the bullet 
Numbered paragraphs Arabic number followed by a full stop at left margin 
Header/footer text Calibri, 11 pt, black 

The default settings for Word may have been altered on your device in your training 
organisation. In this case use your training organisation’s default settings when completing 
exercises. 

Conventions for personal names 
In most western cultures a person has a first name followed by a last, family name; however 
in some eastern cultures the order is reversed. When you encounter a name from a culture 
you are not familiar with, you may not be able to determine which is which. 
Depending on the organisation and the age of its data, you are likely to come across different 
generations of personal name terminology. 
When creating documents, current conventions should be applied. 

Current convention Previous terms 
Given name First name 

Christian name 
Forename 

Family name Last name 
Surname 
Byname 

Group discussion 
If you are learning in a classroom environment, share your name with your fellow learners 
(write it on a whiteboard if available) and discuss the personal naming conventions of your 
culture. 
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Selecting text 
Selecting text (also called highlighting) is used to define text that you wish to do something to 
– delete, move, copy, change the font, size, etc. The most commonly used method of 
selecting text is to hold down the left mouse button and drag across and/or down the text. 
When the insertion point is moved into the Selection Bar area on the left of your document it 

will display as a right-pointing arrow . By dragging up or down in this area you can select 
lines of text quickly. 

 

 
Text can also be selected by using the methods described below. 

Selecting text using the mouse 
A character Click and drag across a character. 
A word Double click in a word. 
A sentence Ctrl click anywhere in a sentence. 
A line Move the mouse pointer into the Selection Bar and click. 
A paragraph Move the mouse pointer into the Selection Bar. Point to the 

paragraph and double click. 
OR  
Triple click in the actual paragraph. 

To select text between 
two points 

Click at the beginning of the text to be selected. Move the insertion 
point to the end of the text. Hold down the Shift key and click. 

Random selections Hold down the Ctrl key and select each group of text. 
To select the whole 
document 

Press Ctrl A. 
OR  
Triple click in the Selection Bar. 

If text is selected and you press a key on the keyboard the text will be overwritten or deleted. 

Basic text editing summary 
Editing feature Procedure 
Insert content Inserting is automatic. Click the insertion point to insert text and 

just type the text to be inserted. 
New paragraph Place the cursor on the left of the first character of the intended 

new paragraph and press Enter. Word default paragraph 
spacing automatically inserts an 8 pt space. 

Join paragraphs Place the cursor at the end of the first paragraph and press 
Delete.  
OR 
Place the cursor at the beginning of the second paragraph and 
press Backspace. Press Spacebar once. 

Selection Bar 
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Editing feature Procedure 
Delete to right of cursor Press the Delete key. 
Delete to left of cursor Press the Backspace key. 
Delete a blank line Place the cursor on the blank line and press Delete. 
Insert a blank line Place the cursor below the line to be inserted and press Enter. 
Undo last action(s) 

Click on the Undo button  or use the keyboard shortcut 
Ctrl Z. 

Redo last undo 
Click on the Redo button  to redo the last undo OR use the 
keyboard shortcut Ctrl Y. 

Typing replaces selection Select text and type new text. 

Moving and copying text  
Text and other elements of a document can be cut (moved) or copied to the Clipboard and 
pasted to another location, document or app. The Clipboard Group on the Home Ribbon 
contains the controls used for moving and copying. 

 

Moving  Select the text to be moved. 1.

 Click on the Cut button  OR use the keyboard shortcut Ctrl X. 2.
 Move the cursor to where you wish to move the text. 3.

 Click on the Paste button  OR use the keyboard shortcut Ctrl V. 4.
Copying  Select the text to be copied. 1.

 Click on the Copy button  OR use the keyboard shortcut Ctrl C. 2.
 Move the cursor to where you wish to copy the text. 3.
 Click on the Paste button OR use the keyboard shortcut Ctrl V. 4.
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Formatting text 
The Font Group on the Home Ribbon provides tools for formatting text. 

 

 
 

Font sizes 
Fonts are measured in points (pt). There are 72 points to 2.54 cm.  

Font half sizes 
Font half sizes such as 11.5 pt can be typed into the Font Size box. 
Exercise 2 

 Using Exercise 1… select the Many types subheading. 1.

 With the Home Ribbon displayed click in the Font Size box to select the number 2.

displayed . 
 Type: 15.5 and press Enter. 3.
 Use the function key F4 to apply the same formatting to the second subheading Using a 4.

broker. 
F4 is a shortcut key for repeat.  

 Save the file and leave it open for the next exercise. 5.

Formatting paragraphs 
The Paragraph Group on the Home Ribbon contains tools for formatting paragraphs. 
 
 

 
 
 
  

Font Size Change Case 

Align Right 

 
  

Justify 

 
 

Decrease Indent 

 
  

Increase Indent 

 
  Align Left 

 
  
Center 

 
 

 

Line and Paragraph 
Spacing 

 
   

 

Show/Hide 

 
 

Font 

Bold 

Italic 

Font Color 

F4 
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Indenting numbered paragraphs 
 Select the numbered paragraphs and click the right mouse button. 1.
 Select Adjust List Indents. 2.

The Number position is the position of the number relative to the left margin. 
The Text indent is the position of the text relative to the left margin. 

 
 Click on OK. 3.

This technique will not work if you have skipped numbers for some paragraphs or if you have 
blank lines between numbers. 
If you need to change the indent of a numbered list which contains blank lines, use the 
Increase  and Decrease  Indent buttons on the Home Ribbon. 
Exercise 11 

 Create a new document and remove line spacing and paragraph spacing. 1.
 Set the font to Calibri 12 pt. 2.
 Type the heading shown below and format appropriately. 3.

NEWVIEW NETWORK TELEVISION 
 
Each NEWVIEW channel is individually dedicated to bringing you the world’s best in 
news, movies and sport. 

1. The NEWVIEW News Channel brings you 24 hours of national and international 
news and information from the BBC and the legendary CNN. 

2. The NEWVIEW Movie Channel, presented by HBO (Home Box Office – the 
world’s greatest movie channel), screens the best movies available, 100 per 
cent commercial free. 

3. The NEWVIEW Sports Channel presents 24 hours of national and international 
sport – most of it live and exclusive to NEWVIEW. 

Our monthly magazine NEWVIEWS contains all the information you’ll need. It is 
designed to maximise your subscription to NEWVIEW television. 

 Type the first paragraph and press Enter. 4.

 Click on  to insert the first number. It will be indented automatically. 5.
 Type the first numbered paragraph shown below. 6.
 Press Enter to insert the second number. 7.
 Continue in this way down to the last numbered paragraph. 8.

 Press Enter after the third numbered paragraph then click on  to turn off numbering. 9.
 Type the last paragraph. 10.

Ctrl N 
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Document design concepts 

Balance 
Balance is about arranging the content of a document so that it looks tidy, inviting and is 
easy to read. 
White space is the area of the document without content. Good white space usage includes 
ensuring there is enough space between paragraphs and above headings. Even margins 
provide an equal amount of white space around the text.  

On the Insert tab, the galleries 
include items that are designed to 
coordinate with the overall look of 
your document. You can use 
these galleries to insert tables, 
headers, footers, lists, cover 
pages, and other document 
building blocks. When you create 
pictures, charts, or diagrams, they 
also coordinate with your current 
document look. 

You can easily change the 
formatting of selected text in the 
document text by choosing a look 
for the selected text from the 
Styles gallery on the Home tab. 
You can also format text directly 
by using the other controls on the 
Home tab. Most controls offer a 
choice of using the look from the 
current theme or using a format 
that you specify directly. 

 On the Insert tab, the galleries 
include items that are designed to 
coordinate with the overall look of 
your document. You can use these 
galleries to insert tables, headers, 
footers, lists, cover pages, and 
other document building blocks. 
When you create pictures, charts, 
or diagrams, they also coordinate 
with your current document look. 

You can easily change the 
formatting of selected text in the 
document text by choosing a look 
for the selected text from the Styles 
gallery on the Home tab. You can 
also format text directly by using 
the other controls on the Home tab. 
Most controls offer a choice of 
using the look from the current 
theme or using a format that you 
specify directly. 

Unbalanced  Balanced 

If your document contains images, check the image size and the text arrangement 
complement each other. Do not let a small image be swallowed up by lots of text, but also 
check a large dominant image does not overpower the text. 

Simplicity 
The concept of simplicity is about presenting information in a way that can be understood 
easily. It is particularly important business documents are set out with the concept of 
simplicity in mind. The layout should be tidy with appropriate use of white space making it 
easy to view and read. 

• Do not cram a lot of information into one small section – spread it out over the page or 
pages. 

• Do not use too many colours or too many different text types as this can make the 
document difficult to read. 

• Do not try and crowd too many images onto a page. 

• Do not make the mistake of thinking simplicity equals boring. 

• It is possible to introduce interest to your document with the judicious use of colours and 
images as long as they are appropriate. 
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Protecting documents with a password 
Passwords can be used to prevent others from opening a file. Passwords are case sensitive, 
If you protect a file with a password, you must provide the password each time you open the 
document, typing uppercase and lowercase letters exactly as you did when you specified 
the password. 
Exercise 27 

 Using Exercise 26… click on  and check  is selected. 1.

 Click on  and select . 2.
 In the Password: box, type a password of your choice. The password will appear as 3.

bullets as shown below.  

 
 Click on OK. 4.
 Retype the password to verify it and then click on OK. 5.

 Click on  to return to the document. 6.
 Save and close the document. 7.
 Open the document. 8.
 Enter your password and click on OK. 9.
 Leave the document open for the next exercise. 10.

Removing encryption 
Exercise 28 

1. Using Exercise 26… click on , click on  and select Encrypt with 
Password. 

2. Delete the bullets from the Password: box. 
3. Click on OK. 
4. Save the document and leave it open for the next exercise. 
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Styles 
A style is a set of formatting instructions combined into a meaningful name that can be 
applied easily to text, e.g. Heading 1 style could be formatted as Arial 14 pt, left aligned, 
bold. Styles provide consistency to your work and when a style is edited, all occurrences of 
that style will change throughout the document. 
Styles can be applied and edited using the Styles Group on the Home Ribbon. This is 
referred to as the Styles Gallery: 

 

Clicking on the More button  displays more styles in the Styles Gallery. 
New styles can be created to incorporate any formatting. Styles can also be used to generate 
a table of contents. 

 
Growing beautiful roses 
General information 

No other plant provides so many delightful flowers over such a long 
season as roses. Their variety form, from old fashioned types, modern 
hybrids, miniatures, bush, standard and climbers give roses a multitude 
of uses and a place in every garden. Roses are hardy plants and they 
will even survive neglect; however, care and attention will result in 
improved plant vigour, size and quality of blooms and a very satisfying 
reward. 

Soil 
Roses prefer a soil which has a good water holding capacity but is 
never waterlogged. A clay loam is ideal, but roses will grow in most 
soils. Improve light soils by digging in plenty of compost and prepare 
the ground by deep digging prior to planting. If drainage is a problem, 
try raised beds (at least 30 cm above ground level). 

The document above shows the styles from the Word default style guide. The styles are 
formatted as: 

Heading 1 Calibri Light, 16 pt, blue, 12 pt spacing before 
Heading 2 Calibri Light, 13 pt, blue, 2 pt spacing before 
Normal Calibri, 11 pt, left aligned, black, 1.08 line spacing, 8 pt spacing after 

Shortcut keys 
The following shortcut keys can be used to apply styles: 

Heading 1 Alt Ctrl 1 
Heading 2 Alt Ctrl 2 
Heading 3 Alt Ctrl 3 
Normal Ctrl Shift N 

Normal style 

Heading 1 style 

Normal style 

 
  

Heading 2 style 

Heading 2 style 
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Applying organisational style guides 
Applying and editing styles are an efficient way of setting text attributes to follow an 
organisational style guide. The following style guide will be used for Exercise 32 to Exercise 
37. 

Style Description 
Normal (main text) Calibri, 11 pt, 6 pt spacing after 
Heading 1 Arial, 18 pt, bold, 8 pt spacing after 
Heading 2 Arial, 14 pt, bold, 6 pt spacing after 
References Calibri, 11 pt, 1.27 cm hanging indent 
Report Title 1 Calibri, 24 pt, centred, double-bottom border 
Emphasis Calibri, 11 pt, bold, italic 
Small Caps Calibri, 11 pt, bold, italic, small caps 

Editing styles 
Editing existing styles provides a fast method of keeping a document consistent. 

Style by example 
Exercise 32 

 Use the Save As function to save a copy of Exercise 31… with the file name Exercise 1.
32…. 

 Press Ctrl Home and select the heading Introduction. 2.
 Press Ctrl Shift F to open the Font dialog box. Format the heading to Arial 18 pt, Bold, 3.

Automatic Font color. 
 Click on OK. 4.
 Display the Paragraph dialog box. Set paragraph spacing to 0 pt spacing before and 8 pt 5.

spacing after. Click on OK. 
 Right click on Heading 1 in either the Styles Gallery or the Styles pane. 6.
 Select Update Heading 1 to Match Selection. 7.

 
All text formatted to Heading 1 will update with the new look. 

 Select the text Subjects and format to Arial 14 pt, bold, automatic font colour. 0 pt 8.
spacing before and 6 pt spacing after. 

 Right click on Heading 2 in Styles Gallery or the Styles pane and update all text formatted 9.
to Heading 2. 
 Deselect all text. 10.
 Save the document and leave it open for the next exercise. 11.

  

Ctrl Shift 
F 
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Headers and footers 
A header is the content that is repeated on the top of every page. 
A footer is the content that is repeated on the bottom of every page. 
Content could include images, text, page numbers and dates. 

 
The Header & Footer Group on the Insert Ribbon is used to create and edit headers and 
footers. 

 
Word provides built-in headers and footers or they can be created from scratch. 
When editing the header or footer, the following tab will be added to the Ribbon. 

 

 

 
Word 365 Word Professional  

Built-in headers and footers 
To insert a built-in header or footer: 
1. Click on the Header or Footer button to display the Built-in list. 
2. Select the header/footer style required. The header or footer will open ready for editing. 

3. The header/footer contains a series of fields, e.g. . Click on a field and enter 
the data required. 

4. In the case of a date field click on an  to display a calendar and select the date. 

 

Ross Veterinary Services 

 
 
 
 
 
 

 

 

Ross Veterinary Services 

 
 
 
 
 
 

 

 

Ross Veterinary Services 

 
 
 
 
 
 

 

 

Header 

Footer 
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Integrating Excel data into Word 
Documents often include data from other apps. Numerical data, charts and presentation 
slides are just some of the content that can be inserted into in a Word document. 

Starting Excel and opening a spreadsheet 
Exercise 78 

1. With Word still open click on the Start button . 

2. Click on  to open Excel. 

3. Click on . 

4. Click on  to display the Open dialog box. 
5. Navigate to the 978-1-921971-57-0 BSBTEC301 exercise files folder. 

6. Select the file called Care Cosmetics November and click on . 

7. Leave the file open for the next exercise. 

Switching between windows 
When working with multiple apps, you need to be able to switch between them. 

Using the Taskbar 
Buttons can be added to the Taskbar for commonly used apps. 

• When an app is open, a bar is displayed below the button. 

• When multiple instances of the app are open, the button has shading added. 
To switch to the required window click on the Taskbar button. If multiple instances are open, 
clicking on the button will display a preview of each instance. Click on the one required. 
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Evidence guide 

Elements and performance criteria  
Element 
Elements describe 
the essential 
outcomes. 

Performance Criteria 
Performance criteria describe the performance 
needed to demonstrate achievement of the 
element. 

Assessment tasks 

1. Select and 
prepare resources 

1.1 Select and use technology and software 
applications to produce required business 
documents 

Task 1, Task 2, Task 3, 
Task 4, Task 5 

1.2 Select layout and style of publication 
according to information and organisational 
requirements 

Task 1, Task 2, Task 3, 
Task 4, Task 5 

1.3 Use basic design principles and ensure 
document design is consistent with 
organisational requirements 

Task 1, Task 2, Task 3, 
Task 4, Task 5 

1.4 Discuss and clarify format and style with 
required stakeholder 

Task 3 

2. Design 
document 

2.1 Identify, open and create files according to 
task and organisational requirements 

Task 1, Task 2, Task 3, 
Task 4, Task 5 

2.2 Design document and ensure efficient 
entry of information 

Task 1 

2.3 Use a range of functions to ensure 
consistency of design and layout 

Task 1, Task 2, Task 3, 
Task 4, Task 5 

3. Produce 
document 

3.1 Complete document production according 
to organisational policies, procedures and 
requirements 

Task 1, Task 2, Task 3, 
Task 4, Task 5 

3.2 Check document produced to ensure it 
meets task requirements for style and layout 

Task 2, Task 3, Task 4, 
Task 5 

3.3 Store document appropriately and save 
document 

Task 1, Task 2, Task 3, 
Task 4, Task 5 

3.4 Use help function to overcome basic 
difficulties with document design and 
production, where required 

Task 4 

4. Finalise 
document 

4.1 Proofread document for readability, 
accuracy and consistency of language, style 
and layout prior to final output 

Task 2, Task 3, Task 5 

4.2 Modify document according to task 
requirements 

Task 2, Task 3, Task 4, 
Task 5 

4.3 Name and store document in accordance 
with organisational requirements and exit 
application 

Task 1, Task 2, Task 3, 
Task 4, Task 5 

4.4 Present document according to task 
requirements 

Task 2, Task 3, Task 4, 
Task 5 
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Assessment Requirements 
Performance Evidence 
The candidate must demonstrate the ability to complete the tasks outlined in the elements, 
performance criteria and foundation skills of this unit, including evidence of the ability to: 

• design, produce and finalise four different types of business documents, using at least 
two different software applications. 

In the course of the above, the candidate must: Assessments tasks 
• comply with organisational policies and procedures for 

producing business documents 
Task 1, Task 2, Task 3, 
Task 4, Task 5 

• adhere to task requirements when producing documents 
including: 

 

• applying basic design principles 

• applying consistent formatting 

• using appropriate styles 

• using correct layouts 

• proofreading 

Task 1, Task 2, Task 3, 
Task 4, Task 5 

• use required data storage options Task 1, Task 2, Task 3, 
Task 4, Task 5 

Knowledge Evidence 
The candidate must be able to demonstrate knowledge to 
complete the tasks outlined in the elements, performance criteria 
and foundation skills of this unit, including knowledge of: 

Assessment tasks 

• technology required for document production Task 1, Task 2, Task 3, 
Task 4, Task 5 

• key functions and features of contemporary computer 
applications 

Task 1, Task 2, Task 3, 
Task 4, Task 5 

• organisational policies and procedures Task 1, Task 2, Task 3, 
Task 4, Task 5 

• organisational requirements for document design, including 
style guide. 

Task 1, Task 2, Task 3, 
Task 4, Task 5 
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